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Paul F. Aubin is best known as the author of many books and video training courses for Revit and other 
Autodesk tools. He has over 30 years of experience in the Architectural industry and has worn many hats 
in that period, from designer, to CAD Manager, technologist, and trainer. He continues many of these in 
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the country. 
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Description: 
Revit has a pretty ingenious way of dealing with project phasing. You do not manually configure each 
object as new, existing or demo. Rather, phases in Revit are like points in time. You develop a timeline of 
your project’s life cycle and then each object is plotted along this timeline. You can view any point in the 
past, present or if you are clever, the future as well by creating phase views. “Existing” happened before 
the project began. Any number of “new construction” phases can be configured after this point. 
Demolition however is not a phase. Instead it is the point in time where an object’s “life” ends. Sound 
intriguing? In this session we’ll learn how to set up phases, configure views and display demolition, 
existing and new construction in appropriate ways. As if that weren’t enough, we’ll even explore a little 
work-around to overcome Revit’s inability to display future work. Intrigued now? Then join us for this walk 
along the Revit timeline! 

Learning Objectives: 
• Understand Revit phasing tools 
• Set up object phasing  
• Configure phasing properties on views 
• Customize the experience 
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Revit Phasing 
Phasing in Revit gives us the ability to apply the fourth dimension—or time—to our projects. Revit’s 
approach to phasing is simple and straightforward. A simple timeline is established for the project that 
includes one or more points in time (each point in time is a phase). The out-of-the-box default project 
template includes just two phases: “Existing” and “New Construction.” You can add additional Phases as 
project needs dictate. (Note: Phases vary slightly in the out-of-the-box Construction and Commercial 
templates). To add or edit Phases, go to the Manage tab, on the Phasing panel and click the Phases tool 
(see Figure 1).  

 
Figure 1—The Phasing dialog is found on the Manage tab on the Phasing panel 

Project Phases 
Every element in your model exists at a period in time defined by two phasing parameters. These are the 
Phase when the element was created and the Phase when it was demolished (see Figure 2).  

 
Figure 2—Every model element has a Phase Created and Phase Demolished parameter on the Properties palette 

The Phase Created setting will default to the same value as the current view when the object is created. 
You can always change it on the Properties palette later if necessary. The Phase Demolished defaults to 
None. This is the correct setting for existing construction to remain.  

The Phasing Dialog 
Access Phasing settings on the Manage tab (see Figure 1 above). This three-tabbed dialog allows us to add 
and remove phases, configure graphical settings for objects assigned to a phase and controls for how 
views will display phased objects.  

The settings on the three tabs are tightly interconnected, so be sure you understand the 
overall concepts and procedures before attempting to customize.  
For example, the most common mistake made by users new to phasing (particularly 
those coming from AutoCAD) is to create a “Demo” phase. This is not the correct way to 
convey demolition in Revit. Every phase in Revit can end with demolition. Demolition is 
the point in time when an object is removed (or demolished). It is not a separate phase.  

Demo 
is not a 
phase 
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Project Phases 

On the Project Phases tab, you can add or remove phases. Your project must have at least one phase, but in most cases 
two (or more) is more appropriate. Every project can make use of the default Existing (what was there before your 
project starts construction, like the site or an existing structure) and New Construction (what you are adding to the 
site, like your building). If your project is more complex than this, you can add additional phases on the Project Phases 
tab. A new phase can be added before or after an existing one. The top of the list is earliest (in the past) and the bottom 
is in the future (see Figure 3).  

 
Figure 3—Phases occur sequentially in time, use the Project Phases tab to create and modify phases 

You cannot delete a phase. Rather, you combine it with the previous or next phase. This will reassign all 
the objects and views in the model appropriately as required.  

Graphic Overrides 
The Graphic Overrides tab lists four “Phase Status” conditions and their 
corresponding settings. Phase Status conditions are built into the software. You 
can edit their characteristics, but you cannot rename, add or delete them. Phase 
Status conditions can be used to graphically override the display of model 
elements at any point in time, based on their phase settings.  
The most important characteristic to understand about Phase Status conditions is 
that they are not static. Each of the Phase Status conditions is relative to the 
currently active phase (in the view). In other words, if you are working in a view set to the Existing phase, 
the objects created in that view will not appear using the “Existing” phase status, but rather they will 
appear as “New!” This is because at that point in time (the earlier phase called “Existing”) they were new 
elements.  
On the other hand, objects that represent new construction in your project do not appear in such a view 
at all. This is because relative to that point in time, they do not yet exist… Just ask Marty… (see Figure 4) 

Phase 
Status is 

relative to 
the current 

view 
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Figure 4—Marty’s view appears to be set to the previous phase…  

Change to another view set to New Construction, and the same objects now displayed grayed out to 
indicate that they are “existing” as seen relative to the current view. Furthermore, all the previously hidden 
new construction now displays. Here is a brief description of each Phase Status condition (see Figure 5) 

 
Figure 5—Revit includes four built-in Status conditions 

Existing—Relative to the currently active Phase, items created in an earlier phase that have not been 
demolished are considered Existing.  
New—Items created in the current Phase and not yet demolished are considered New. 
Demolished—Items created in an earlier Phase and demolished in the current Phase are considered 
Demolished.  
Temporary—This designation is used for items that are both created and demolished within the same 
Phase. 

View Phase Properties 
Like objects, each view is also assigned a Phase. This is the point in time into which we are viewing the 
model. If Doc Brown had been using Revit, he would have set the DeLorean’s View properties to: 1955  
(see Figure 6).  
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Figure 6—Is this the New Construction phase or 1985? 

Another important aspect of the Phase setting is that the Phase assigned to a view is the active Phase for 
that view. In other words, if a plan view is assigned the Existing Phase, all elements drawn in that view will 
automatically inherit this setting and become existing elements. You can of course override the setting by 
editing the element’s properties but working with the currently active view Phase can be a much more 
efficient way to work. It is often desirable to create a view for each major Phase of work and then simply 
make the appropriate view active before drawings any objects.  

Phase Filters 
View properties also have a Phase Filter setting. (Return to the Phasing dialog to configure them). This is 
how you display the graphical overrides built into each of the Phase Status conditions noted above in the 
current view. A Phase Filter determines how (and if) objects assigned to each Phase will display in the 
current view (see Figure 7).  

 
Figure 7—Phase Filters determine what displays in a view and how (or if) it is overridden  

Show All is built in and cannot be changed. Several others are included with the default templates and you 
can customize these and/or create your own. For each of the four Phase Status conditions, you can 
choose one of three options:  
By Category—This setting makes no change to the item’s display. They will display using their default 
settings as determined by the Object Styles command (Manage tab) and/or any Visibility/Graphics 
overrides. 
Overridden—This setting applies the override listed on the Graphic Overrides tab to elements meeting 
this Phase Status condition. (Making existing gray or demo dashed for example). 
Not Displayed—When this setting is active, elements meeting the condition are invisible in the view.  
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In all three cases, view specific overrides are still possible using Visibility/Graphics (VG) or object level 
overrides.  
Remember, all conditions are relative to the current view’s Phase setting. So, if you have two new 
construction phases such as: Phase 1 New Construction and a Phase 2 New Construction, items added 
and displayed as new construction in a Phase 1 view will appear as existing in a Phase 2 view.  
The best way to get a good sense of the behavior of each of the Phase Filters included in the out-of-the-
box template is to try them out one at a time. Before doing so, create an additional Phase like Phase 2 
New Construction. With at least three Phases, the various filters will be easier to understand (see Figure 8).  

 
Figure 8—The combination of phases and phase filters 

Working with Phasing – Procedure 
The most efficient way to work with Phasing is to create views for each major Phase. In this way, when you 
add new elements to your model, they will be added automatically to the correct Phase.  

Here is an overview of the steps:  
Open the Phasing dialog (Manage tab) and edit or add Phases if required. 
Note: The default project settings include Existing and New Construction phases and all new views default to New 
Construction unless you specify otherwise.  

1. At minimum, create an Existing construction floor plan view for each level of 
the project. (Add other kinds of views (sections, elevations, etc.) as 
required). 

2. Open the First Floor Existing floor plan view and layout the Walls, Doors and 
Windows of any existing construction. 

3. Switch to the New Construction views and add geometry representing the 
new work. 

4. Repeat for each Phase/view combination you have.  
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5. As you work, you can switch between views to add or edit geometry or 
simply edit the properties of an element to change its Phase settings on the 
Properties palette after it is drawn.  

6. Using the hammer icon on the Modify tab, Geometry panel (or the 
Properties palette), demolish any elements as required.  

Hands-on 
This topic includes a hands-on exercise to explore the phasing toolset.  

Phasing Basics 
In this first exercise, we will get acquainted with the 
mechanics of working with Revit’s phasing tools.  
All steps and screen shots here are Revit 2020 (Architectural 
configuration), but most should work in other flavors or 
versions.  
Steps have been kept brief to improve the flow of the hands-
on portion. Please refer to the topics above if required for 
further details on the concepts showcased herein.  
 
 

1. In your web browser, visit: https://paulaubin.com/conferences/  

2. Download the files for this session. If necessary, use the Conference Archives link to search for 
them. Search by session name, conference or topic. The Revit version used for these files is 
2020. 

3. If Revit is not already running, launch it now.  

4. From the File Menu, (or on the Recent Files screen), choose Open > Project.  

5. Browse to the folder where you downloaded the above dataset files and open the file named: 
01_Timeline.rvt.  

A very simple building plan appears. (This file was built from the out-of-the-box default.rte Revit 
template).  

Assign objects to Phases 
Let’s see what happens when we change the phase that some of the objects in this file.  

1. Make sure that the Level 1 floor plan is active. Select the vertical Wall on the right side of the 
plan. 

2. On the Properties palette, for the Phase Created parameter, choose Existing. Deselect the Wall  
(see Figure 9).  

https://paulaubin.com/conferences/
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Figure 9—Change the Phase Created on the Properties palette 

Notice how when you deselect the Wall, it turns gray and a lighter lineweight.  

3. Select the two horizontal Walls adjacent to the one just edited. (Select just the Walls, not the 
Windows yet). Change them to Existing the same way.  

Notice that the Walls change the same way, but that the Windows in the lower Wall remain new 
construction. This triggers the Window openings to become demolition! Very cool (see Figure 10).  

 
Figure 10—Demo for the Window openings is managed automatically 

If you want the Windows to be existing, you must change them as well.  

4. Select one of the Windows in the lower Wall. On the Properties palette, change it to Existing the 
same way.  

When changing the window to existing, the demo disappears because it is no longer necessary. Both the 
wall and window are created in the same phase, so no demo is required. Doors work the same way. What 
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happens if you change just a Door or Window to Existing without first changing the Wall? No demolition 
will be created, but in an existing view, you would have a Door or Window with seemingly no host. That 
would be a little odd indeed. More common is the case where a new Door or Window is added to an 
existing Wall. Let’s try that. 

5. Create a new Door near the top of the vertical Wall at the right (see Figure 11).  

 
Figure 11—Add a new Door and the Wall hole is shown as demo automatically 

Notice how the opening for the Door is automatically demolished from the existing Wall.  

Demolition 
Now let’s demolish some elements.  

6. On the Modify tab, on the Geometry panel, click the Demolish tool.  

7. Click on the top horizontal existing Wall. 

The Wall now displays as dashed indicating it is demolished.  

8. Demolish some additional items (see Figure 12). 

 
Figure 12—Use the Demolish tool to demo various objects (Do the vertical wall last) 
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Demolishing a Door or Window will infill a piece Wall at the opening automatically. If you demolish an 
element in the same phase it was created, it displays differently. (dashed and hatched by default). This 
indicates temporary construction (see the right side of the figure).  
So, what exactly does the Demolish tool do? It just changes the Phase Demolished setting on Properties 
palette for the selected element. It is a convenient way to do this and kind of fun. 

9. Cancel the Demolish tool and then select the horizontal Wall demolished above. 

10. On the Properties palette, take note of the Phase Demolished parameter. 

11. Repeat for the temporary Wall and a Wall that is not demolished (see Figure 13). 

 
Figure 13—Using the Demolish tool simply changes the Phase Demolished parameter on the Properties palette 

Studying these settings exposes an alternative to the Demolish tool. If you prefer, you can simply select 
the phase at which an object is demolished from the Phase Demolished parameter on the Properties 
palette. To “un-demolish” an object, set this parameter to None.  
A good way to think of these settings is that you are litteraly setting the “lifespan” of each element in your 
model. The object is “born” at the Phase Created setting and “dies” at the Phase Demolished setting. Your 
project and its views is nothing more than a snapshot of this timeline (see Figure 14).  

 

Figure 14—Phasing parameters are like the lifespan of your model elements 
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Understanding Phasing Settings 
Now that we understand the mechanics involved in changing an object’s phasing parameters, let’s dig a 
little deeper into how to configure phasing settings.  

Add Phases 
Most projects are well served by the two phases provided in the default project template. These phases 
give a clear distinction between existing, demolition and new construction. However, in more complex 
projects where construction is staged across multiple phases, you can add additional phases to the list. 
You add phases in the “Phasing” dialog1.  

1. On the Manage tab, on the Phasing panel, click the Phases button.  

On the Project Phases tab, we can add or remove phases. You must have one phase, but most projects 
will have two or more. Phases are points in time. So, before you add a phase, decide if it comes before or 
after the phases already in the list.  

2. On the Project Phases tab, select New Construction and then on the right, click the After button.  

A new Phase 1 will appear.  

3. Rename this New Phase 2 and rename New Construction to New Phase 1. Add descriptions if 
you like and then click OK (see Figure 15).  

 
Figure 15—Edit the Phases and add a new one 

This change is global. All elements previously assigned to New Construction now use New Phase 1 
instead.  

4. To the right of the existing building, use the Wall tool and create a new building approximately 
the same size as the existing main building.  

5. Add some Doors and Windows. 

6. At the top of the plan, draw a wall between the two buildings (see Figure 16).  

 
1 It should be noted that the names of the phases can be changed to anything you like. So if you are 
not satisfied with the default names of “Existing” and “New Construction” there is nothing special or 
required about these names. Further, it is possible to merge phases together if you do not need all the 
phases in the list. This means that it is possible to have only one phase if you like. However, in my 
view, two is a much better and more accurate minimum. Even in projects with only new construction 
on a new piece of land, the land itself is “existing.”  
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Figure 16—Create new geometry 

Selecting any of the elements just drawn reveals that all the elements are assigned to New Phase 1. How 
does Revit know which phase to assign to new elements? The phase assigned to new elements is 
determined by the view in which they are drawn. 

Assign Phases to Views 
Like model elements, views also have a phase parameter on the Properties palette. This is used to 
determine what is seen in that view and what phase new elements inherit.  

7. Deselect all elements to make sure that the Properties palette is showing the properties of the 
Floor Plan.  

8. Scroll down and notice that the Phase parameter is set to New Phase 1. Don’t change anything 
yet.  

9. Select the Wall between the two buildings and change it to New Phase 2.  

It disappears! This is because relative to the current view, which as we saw is set to New Phase 1, this Wall 
does not exist yet.  

10. Deselect the Wall and for the Level 1 view, change the Phase setting to Existing.  

Notice that all elements not assigned to the Existing phase disappear and the existing elements remaining 
now display bold as if they were new construction. This is very important because in Revit, what it means 
to be “Existing”, “Demo” or “New” is not static. Rather it is relative to the setting of the view in which it is 
seen! 
The Phase setting for the view’s properties is like setting the destination time in the DeLorean. Remember 
when Marty went back in 1955 and tried to go to his house? It was the same tract of land, but his 
subdivision had not even been built yet! (see Figure 4 above) 

11. For the Level 1 view, change the Phase setting to New Phase 2.  

Now everything turns gray except the one Wall between the buildings which we moved to this phase.  
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12. Draw another Wall between the two buildings near the bottom of the plan this time. Ignore any 
warnings (see Figure 17).  

 
Figure 17—Objects take on the phase of the view at the time they are created 

As you can see, if the view is set to the correct phase, it is easier to add elements because they inherit the 
correct phase automatically. Therefore, it is best practice to create a few copies of the view: one for each 
major phase where work is being performed. In this way, you can quickly view each phase and add or edit 
objects easily.  

Clean up 
Before we get too much further, let’s clean up the phase assignments of the rest of the geometry. The 
building on the far left is existing to remain. The addition to it in the middle will be demolished at the end 
of Phase 1. The new building that we drew on the right is created in Phase 1 and finally the connector 
building in the middle (just the two Walls currently) is built in Phase 2.  

13. Make a window selection around the building on the left (drag from top left to bottom right).  

Notice that the Phase settings on the Properties palette are grayed out. This is because of the Curtain 
Wall. You cannot assign the sub-elements of a Curtain Wall (which are currently part of the selection) to a 
different phase than the parent Curtain Wall. (We will discuss this below).  

14. On the ribbon, click the Filter button and uncheck Curtain Panels, Curtain Wall Grids and Curtain 
Wall Mullions. Click OK and then using the SHIFT key, deselect the Curtain Wall Door (see Figure 
18). 

15. On the Properties palette, change the Phase to Existing.  
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Figure 18—Use the Filter command and SHIFT key to deselect Curtain Wall elements 

16. Deselect all objects and on the Properties palette, set the Phase for the Level 1 view back to New 
Phase 1. 

17. Change the Phase setting of the view back to: New Phase 1.  

18. Using the CTRL key, select the Walls of the small addition in the middle, the two Windows and 
the Doors. (Hint: don’t select the Wall infills by the Windows.) 

19. Include the vertical wall and door previously set to temporary construction.  

20. Set their Phase Created parameter to Existing and the Phase Demolished parameter to New 
Phase 2 (see Figure 19). 

 
Figure 19—The catchup file has the elements phased correctly 
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CATCH UP! You can open the file completed to this point named: 02_Timeline.rvt.  

We’ll use the catch-up file here to continue. All the objects have been assigned the correct phase, and a 
few more elements were added. Now we need to create and configure the views.  

Duplicate and assign phases to views 
To see the results of the changes we just made, let’s duplicate the plan view a few times.  

1. On the Project Browser, right-click the Level 1 view and choose Duplicate View > Duplicate. 
Rename it to Level 1 (Exist).  

2. Repeat twice more creating Level 1 (Phase 1) and Level 1 (Phase 2). 

3. All three views should have opened as tabs. Click the Level 1 (Exist) tab to make it current. 

4. Make sure no objects are selected and on the Properties palette, change the Phase to Existing.  

5. Repeat for the other two views.  

Phase Filters 
As you can see, the objects change display characteristics based on the phase assigned to the view. It is 
like a window looking at just a limited portion of our timeline. However, the other very important behavior 
here has already been noted above: what it means to be “Existing”, “Demo” or “New” is not static. This is 
controlled by Phase Filters and Graphic Overrides. You can refer to the general descriptions of these 
features above, in this sequence we’ll explore them first-hand.  

6. Compare the Level 1 (Phase 1) and Level 1 (Phase 2) floor plans.  

The Phase 1 plan is easy to understand, but the Phase 2 plan is a little busy. Phase Filters can help to limit 
what is displayed in a view and where appropriate override the graphics. Let’s explore a few.  

7. Open the Level 1 (Phase 2) floor plan. 

8. Make sure no objects are selected and on the Properties palette, change the Phase Filter to: 
Show Demo + New.  

Not perhaps a setting you would use for views destined for plotting, but it could be helpful for 
troubleshooting if object’s phases are properly configured. There are a couple others with similar 
diagnostic value: 

9. Try Show New and then try Show Previous Phase.  

Be careful with Show Previous Phase as you can draw new objects in this mode, but they will not appear! 
Revit will warn you, but just the same it can be confusing if someone leaves a view set this way. 
The next two that we are going to try do have utility in plotted views.  

10. Try Show Previous + Demo next.  

This is basically your typical demolition plan. Again, the same caution applies about drawing new objects 
as “new” construction is not displayed in this filter. But you can set a view this way, add demolition notes 
and serves very well for a demo plan.  
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11. Duplicate the current view, rename it to: Level 1 (Demo) and leave it assigned to the Show 
Previous + Demo Phase Filter. 

12. Reopen the Level 1 (Phase 2) floor plan. Change the Phase Filter to Show Previous + New. 

This is a typical floor plan. It shows existing and new construction. Notice that since the current view has 
its Phase set to New Phase 2, both the left and right buildings appear gray. Remember, what it means to 
be “existing” or “new” is relative to the active Phase.  

13. Double-click the Level 1 (Phase 1) floor plan. Change the Phase Filter to Show Previous + New. 

Notice that the building on the right is now bold. In this view, it is “new” construction.  

14. Reopen the Level 1 (Phase 2) floor plan (see right side of Figure 20).  

 
Figure 20—Phase Filters can dramatically impact what is displayed in the view 

15. Try the last two options of Show Complete and None. Set it back to Show Previous + New when 
done.  

Show complete displays how the building looks when the project is finished. So, there is no longer a need 
to show any demolition nor to show existing and new differently, so all construction shows bold.  
When you choose: None, there is no filter applied. So even though phasing settings still exist, they are no 
longer expressed graphically.  
Graphic Override Settings, View Phase Properties and Phase Filters were all discussed in topics above. If 
you want to explore the settings a bit more, on the Manage tab, on the Phasing panel, click the Phases 
button. Phase Filters have three options for each condition. To leave objects alone and apply no overrides, 
leave the setting at By Category. Not Displayed makes elements invisible. When it says Overridden, the 
settings on the Graphic Overrides tab apply. Feel free to explore the settings on your own.  

Special Considerations 
That concludes most of the basic procedures for phasing. In the topics that follow, we will consider many 
special cases and considerations with respect to the phasing toolset.  

Copy and Paste 
When you copy and paste elements, the phasing is NOT retained! Always make sure you paste into a view 
that is set to the phase you want to use. If you don’t you will have to adjust the phasing of the pasted 
elements afterwards.  
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Schedules 
Schedules are views. Therefore, the same rules apply. They are assigned to a Phase and Phase Filter. Only 
elements allowed by that Phase and Filter combination will be displayed (see Figure 21).  

 
Figure 21—Schedules like other views have both Phase and Phase Filter settings 

Use a View list schedule 
When you have a project with many views, you should consider creating a View List Schedule to manage 
their settings. A View List is simply a schedule of your project’s views. The nice thing about a View List is 
that you can edit directly in the schedule which can often be more efficient than opening one view at a 
time  
(see Figure 22). 

  
Figure 22—You can use a View List Schedule to edit the settings of a view 
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Curtain Walls 
You cannot demolish part of a Curtain Wall. So, if you are keeping most of the Curtain Wall but need to 
demo just a few bays to add a door or some other feature, you must be clever about how you handle it.  

 
Figure 23—You cannot demolish a portion of a Curtain Wall, instead you must manually break the Curtain Wall 
into sections 

Start by removing the Grid segments and Mullions in the area that you want to demolish. Select the Panel 
that remains and choose Empty System Panel. You cannot delete it; you must use the Empty Panel  
(see Figure 23).  
Next, draw a new Curtain Wall in the place where you created the void. You can then demolish this smaller 
Curtain Wall, which will automatically demolish its Mullions and panels. Finally, build a new Curtain Wall in 
the same location for the new construction and assign it to the proper phase.  

Roofs and Floors 
Roofs and floors are similar to Curtain Walls. You cannot demolish part of a Roof or Floor Slab. Instead, 
you’ll have to build it in two or more pieces and demolish the part you want to demolish and build a new 
Roof or Floor in that location for the new construction. An example is provided in the dataset.  

Topography 
Topography and Building Pads can be a little challenging when it comes to phasing. You assign Phase 
Created and Phase Demolished settings just like other model elements. Revit has some very basic Cut and 
Fill calculation tools. You will find a tool on the Massing & Site tab, Modify Site panel, named Graded 
Region. To use this, it requires that your toposurface be assigned to a previous phase and then it will be 
demolished. In its place, a new surface is created whose grading you modify either point by point or by 
completely regrading all points. You then create a Schedule and include the Cut and Fill fields to quantify 
the results.  
Pads are really the trouble spot. Even though a Pad can be demolished, it influences ALL toposurface 
elements with no regard to phasing. Furthermore, you cannot have two Pads overlapping (even on 
separated phases!), so you must sometimes break them into many pieces to try to properly represent the 
excavation in time. In reality, it is probably easier to do the topography in a separate linked Revit file and 
then do a save-as for the new construction and simply swap in and out the appropriate Linked file.  

Levels and Grids 
Levels and Grids do not use Phasing. You will have to create all the Levels and/or Grids you need and hide 
them manually in views that do not need to see them.  

Rooms 
People often find Revit’s handling of Rooms in phasing a bit baffling. Rooms can only exist in a single 
phase. Or another way of saying it is that each phase must have a complete set of Rooms. When you 
consider that Rooms conform to the shape of the surrounding geometry, you could end up with many 



Revit Timeline: Understanding Revit Phasing 19 

situations where Room shapes change radically from one phase to the next given the demolition of even a 
few Walls. Not to mention that many Rooms would likely overlap one another after such edits, and you 
can hopefully begin to appreciate the issue.  
So, while this is little comfort in those cases where many (or most) Rooms are unchanged from one phase 
to the next, remember that Copy and Paste (as noted above) do not retain their phasing. Therefore, all you 
must do is copy all the Rooms that are unchanged from a view and paste them into a view in the next 
phase. Then you add any missing or new Rooms as required. Let’s do a quick example.  

CATCH UP! You can open the file completed to this point named: 03_Timeline.rvt.  

1. On the Project Browser, double-click the Level 1 (Exist) plan.  

There are three Rooms here and a Room Separation Line. Room Separation Lines behave like other model 
elements. They CAN exist across multiple phases, and then can be demolished. Therefore, in the coming 
steps, you only copy and paste the Rooms, not the separations.  

2. Add Room tags to each Room in the view.  

3. Select Room 101, 103 and their tags. Copy them to the clipboard (CTRL + C). 

4. Double-click the Level 1 (Phase 1) plan. 

5. Demolish the Room Separation line at the top of the plan.  

6. On the Modify tab, click the Paste drop down and choose Aligned to Current View (see Figure 
24).  

 
Figure 24—Rooms occupy only a single phase, copy and paste to more than one 

Notice that the Room on the right conforms to the full space now that the separation line has been 
demolished. You can rename and renumber as desired. It is possible to reuse the same numbers; but Revit 
will complain. You can ignore the warnings, but unfortunately it can be tedious. Using a Schedule or a 
third-party renumber routine is usually the fastest way to renumber many Rooms.  
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Despite the inconveniences of having to rely on copy and paste and with duplicate numbering, copy and 
paste is important since it retains all identity data associated with the Room. So, if you are not changing 
the finishes or other information, this is an important aspect to keep in mind.  

Future Work 
It seems to me that of the provided phase status conditions, the one that is missing is Future Work. There 
is no automated or built in way to have Revit display the future. This is where Marty and his DeLorean 
certainly have a leg up on us. However, it is not too hard to “trick” Revit into displaying a future phase. 
There are a couple approaches that are workable. The first uses a custom Phase Filter, the other uses 
Design Options.  

CATCH UP! You can open the file completed to this point named: 04_Timeline.rvt.  

We’ll use the catch-up file here to continue. This file has some of the preliminary work that we need for 
our future work example already setup to save us a few steps.  

1. Open the 04_Timeline.rvt project file and make sure the Level 1 (Future) floor plan view is open. 

The Level 1 (Future) floor plan view is a copy of the Level 1 (Phase 2) view and is currently configured the 
same way. There are two components to this solution. First, we need to create a new Future Work phase 
at the end of our list of phases. You draw any work not in the current contract but planned for the future 
in this phase. You could theoretically have more than one such phase, but since the next part of the 
solution relies on Phase Filters and Graphic Overrides, it really works best if you can have a single “Future 
Work” phase.  
The second part of the solution takes advantage of the Graphic Override for the New status. If you study 
the list of existing Phase Filters, you will see that none of them uses the override option for New. So, we 
will create a new Phase Filter that overrides new and then we can customize the settings of the new status 
to match how we would like future work to display. We will essentially be using the New status for Future 
in this work around.  

2. On the Manage tab, on the Phasing panel, click the Phases button.  

3. Click the Project Phases tab. 

Notice that there is already another phase here called: Future Work (see Figure 25). 

 
Figure 25—Add a Future Work phase 

4. Click the Phase Filters tab and then click the New button. Name it: Future Work. 

5. In the New and existing columns, choose Overridden. In the Demolished and Temporary columns 
choose Not Displayed (see Figure 26). 
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Figure 26—Configure a Future Work Phase Filter and accompanying override 

6. On the Graphic Overrides tab, you can customize the settings for the New condition to suite your 
preferences.  

7. Click OK to exit.  

The final step is to assign these new settings to the view. (To save time, there is already some geometry in 
the file assigned to the Future Work phase.)  

8. On the Properties palette for the Level 1 (Future) view, change both the Phase and Phase Filter 
to Future Work (see Figure 27). 

 
Figure 27—Assign the view to the new settings to display Future Work 

The downside to this approach is that you can no longer use the Show Complete Phase Filter. This is 
because it would show all the future work as being completed which would not be accurate. If you have a 
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project with future proposed work and you need to use the Show Complete option to show the project at 
the completion of the current contract, you can use Design Options for the Future Work instead.  

Design Options for Future Work 
Design Options do not work the same as Phasing. Curiously however, they are often presented together. I 
think it is because they both offer a way to conditionally manage the display of parts of the model. With 
phasing as we have seen, the determining factor is time. With each phase potentially showing more of the 
completed project than the ones prior (demolition notwithstanding). With Design Options, you are 
creating a fork in the road. If you take one path, you see one thing, take the other path and you see 
something else. In other words, the intention of Design Options is to allow for multiple variations of a 
design idea to be housed and maintained in a single model. However, only one of the options for a work 
area (called an “Option Set”) can be viewed at a time. Design Options do not take time into account at all in 
determining what displays. Rather, each view simply has a setting to determine which design option(s) will 
appear in that view.  
Since Design Options are not limited by time, if we use them to convey Future Work, we can decide which 
views should see the future work and which ones should not; regardless of the current phase.  
The following steps outline the process, but these steps have already been performed in the provided file. If you 
would like to try this process from scratch, you will need to build your own geometry for the future work after 
setting up the design options.  

1. On the Status Bar or the Manage tab, click the Design Options button.  

2. Click the New button for Option Set. 

3. Rename Option Set 1 to Future Phasing. Rename Option 1 (Primary) to Current Work.  

4. Add a second Option and name it: Future Work.  

5. Select Future Work, click the Edit Selected button and then draw the objects representing your 
future work. You can also use the Add to Set button to copy or add existing geometry to this 
option.  

6. When finished, return to Design Options and click Finish Editing (see Figure 28). 

 
Figure 28—Design Options offer a potential alternative approach to Future Work 
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Dismiss the dialog when you are done. When using Design Options, you typically want the option that you 
are most likely to accpet to be the primary, but in the case of future work, we do NOT want the Future 
Work to be Primary or it will show in all views. The Primary Option shows automatically in all views that do 
not have an override. To display our Future Work, we will rely on this override feature to limit where it 
shows.  

7. Create a view to display the Future Work and then edit Visibility/Graphics (VG).  

8. There will now be a Design Options tab, click it and from the Future Phasing Option Set, choose 
Future Work (see Figure 29). 

When you return to the view, the Future Work will display.  

 
Figure 29—Create a view and override its visibility/graphics to display the Design Option  

Since Design Options can show in any view, regardless of phase, we could use this approach to manage 
multiple “future phases” as well. 

CATCH UP! You can open the file completed to this point named: 05_Timeline.rvt.  

Further Study 
You can find more information and tutorials in: 

Renaissance Revit: Creating Classical Architecture with Modern 
Software. This book can be thought of as a “deep dive” into the 
family editor. It starts with the basics but gets very advanced 
as well. The entire book is on family creation using classical 
architectural examples. Both the traditional and massing 
family editors are covered. 
 
The Aubin Academy Revit Architecture: 2016 and beyond. The 
book is authored in an earlier release, but most functions are 
still relevant in current releases. 
 

I also have Revit video training available at LinkedIn Learning. 
Lynda.com has recently been rebranded as LinkedIn Learning. If you are a Lynda.com 

subscriber, you can access all the offerings on that platform as well. If you are 
Professional member of LinkedIn, you already have access to the entire 

training library.  
If you have any questions about this session or Revit in general, you can use the 

contact form at https://paulaubin.com/contact/ to send me an email.  
 

Follow me on twitter: 
@paulfaubin 

 

https://paulaubin.com/books/renaissance-revit/
https://paulaubin.com/books/renaissance-revit/
https://paulaubin.com/books/aubin-academy-revit-architecture/
https://linkedin-learning.pxf.io/XEA0a
https://paulaubin.com/contact/
https://twitter.com/paulfaubin
http://paulaubin.com/books/renaissance-revit/
http://paulaubin.com/books/aubin-academy-revit-architecture/
https://linkedin-learning.pxf.io/XEA0a
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